Safety information

Always follow basic safety precautions when using this product to reduce risk of injury from fire or electric shock.

1. Read and understand all instructions in the documentation that comes with the printer.

2. Observe all warnings and instructions marked on the product.

3. Unplug the printer from wall outlet and remove battery pack before cleaning.

4. Do not install or use this product near water, or when you are wet.

5. Install the product securely on a stable surface.

6. Install the product in a protected location where no one can step on or trip over the line cord, and the line cord cannot be damaged.

7. If the product does not operate normally, see Solve a problem.

8. There are no user-serviceable parts inside. Refer servicing to qualified service personnel.

9. Use only the battery pack supplied or sold by HP for this printer.
# Table of contents

1 How do I? ........................................................................................................................................................................ 1

2 Get started ...................................................................................................................................................................... 2

   Accessibility ................................................................................................................................................................. 2

   HP EcoSolutions (HP and the Environment) .................................................................................................................. 2

   Manage Power ................................................................................................................................................................. 3

   Sleep Mode ................................................................................................................................................................... 3

   Auto-Off ......................................................................................................................................................................... 3

   Quiet Mode .................................................................................................................................................................... 4

   Optimize Printing Supplies ........................................................................................................................................... 5

   Understand the printer parts ........................................................................................................................................... 5

   Front and side view ......................................................................................................................................................... 5

   Printing supplies area ..................................................................................................................................................... 6

   Back view ......................................................................................................................................................................... 7

   Use the printer control panel .......................................................................................................................................... 7

   Lift the control panel ....................................................................................................................................................... 7

   Overview of buttons ......................................................................................................................................................... 8

   Use the Home screen ....................................................................................................................................................... 9

   Paper basics ....................................................................................................................................................................... 9

   Recommended papers for printing .................................................................................................................................. 10

   Order HP paper supplies ................................................................................................................................................. 11

   Tips for selecting and using paper ................................................................................................................................ 11

   Load paper ....................................................................................................................................................................... 12

   Change or set paper settings ......................................................................................................................................... 14

   Update the printer ............................................................................................................................................................ 15

   Use the printer battery ..................................................................................................................................................... 15

   Install or replace the battery .......................................................................................................................................... 15

   Check the battery status .................................................................................................................................................. 16

   To check battery status from the battery .......................................................................................................................... 16

   To check battery status from the printer control panel .................................................................................................. 17

   Battery status ................................................................................................................................................................. 17

   Charge the battery ............................................................................................................................................................ 18

   Store the battery ............................................................................................................................................................... 18

   Dispose the used battery .................................................................................................................................................. 18

   Open the HP printer software (Windows) ....................................................................................................................... 18
8 Solve a problem ................................................. 44

Jams and paper-feed issues ........................................ 44
Clear a paper jam ......................................................... 44
Instructions on clearing paper jams ............................... 44
Learn how to avoid paper jams ...................................... 45
Solve paper-feed problems ........................................... 45

Printing issues ............................................................ 46
Fix problems with page not printing (unable to print) .......... 46
General instructions for resolving unable to print issues ... 46
Fix print quality issues .................................................. 50
General instructions for resolving print quality issues ....... 50

Network and connection issues ..................................... 53
Fix wireless connection ............................................... 53
Find network settings for wireless connection ................. 53
Fix Wi-Fi Direct connection .......................................... 54

Printer hardware issues .............................................. 54
Get help from the printer control panel ............................ 55
Understand printer reports .......................................... 55

Printer status report .................................................... 55
Network configuration page ......................................... 55
Print quality report ..................................................... 56
Wireless test report ..................................................... 56

Solve problems using HP ePrint .................................... 56
Maintain the printer .................................................... 57
Clean the exterior ......................................................... 57
Maintain the printhead and cartridges ............................ 57

Restore defaults and settings ....................................... 58
HP support ................................................................ 58

Appendix A Technical information .................................... 60
Specifications ................................................................ 60

Regulatory information ................................................ 61

Regulatory Model Number ............................................ 61
FCC statement ............................................................ 61
Notice to users in Korea ................................................ 62
VCCI (Class B) compliance statement for users in Japan ... 63
Notice to users in Japan about the power cord ................. 63
Visual display workplaces statement for Germany ............ 63
European Union Regulatory Notice ................................ 63

Products with wireless functionality ............................... 63
Declaration of conformity ............................................. 65
1 How do I?

- Get started
- Print
- Print with HP ePrint
- Work with cartridges
- Solve a problem
2 Get started

This guide provides details about how to use the printer and how to resolve problems.

- Accessibility
- HP EcoSolutions (HP and the Environment)
- Understand the printer parts
- Use the printer control panel
- Paper basics
- Load paper
- Change or set paper settings
- Update the printer
- Use the printer battery
- Open the HP printer software (Windows)

Accessibility

The printer provides a number of features that make it accessible for people with disabilities.

Visual

The HP software is accessible for users with visual impairments or low vision by using your operating system's accessibility options and features. The software also supports most assistive technology such as screen readers, Braille readers, and voice-to-text applications. For users who are color blind, colored buttons and tabs used in the HP software have simple text or icon labels that convey the appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard commands. The HP software also supports Windows accessibility options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper-width guides can be operated by users with limited strength and reach.

Support

For more information about accessibility solutions for HP products, visit the HP Accessibility and Aging website (www.hp.com/accessibility).

For accessibility information for OS X, visit the Apple website at www.apple.com/accessibility.

HP EcoSolutions (HP and the Environment)

HP is committed to helping you optimize your environmental footprint and empowering you to print responsibly—at home or in the office.
For more detailed information about environmental guidelines that HP follows during the manufacturing process, see Environmental product stewardship program. For more information about HP’s environmental initiatives, visit www.hp.com/ecosolutions.

- Manage Power
- Quiet Mode
- Optimize Printing Supplies

**Manage Power**

Use **Sleep Mode**, and **Auto-Off** to conserve electricity.

**Sleep Mode**

Power usage is reduced while in Sleep mode. The printer goes into low-power mode after 5 minutes of inactivity.

You can change the period of inactivity before the printer sleeps.

1. On the printer control panel, press the Home button (Home) to display the Home screen.
2. Select **Setup, Printer Settings**, and then **Power Management**.
   
   To select a function on a screen, use the arrow button ▲ or ▼ to select it, and then press the OK button.
3. Select **Sleep** to change the inactivity time.

**Auto-Off**

This feature turns the printer off after 15 minutes of inactivity to help reduce energy use. Auto-Off turns the printer off completely, so you must use (the Power button) to turn the printer back on. If your printer supports this energy saving feature, Auto-Off is automatically enabled or disabled depending on printer capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.

- Auto-Off is enabled when the printer is turned on, if the printer does not have network, fax or Wi-Fi Direct capability, or is not using these capabilities.
- Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.

**TIP:** To conserve battery power, you can enable Auto-Off, even when the printer is connected or wireless is turned on.

**To manually enable Auto-Off from the HP printer software**

1. Connect the printer to your computer if they are disconnected.
2. Launch the printer software installed on your computer.
3. From the software, click **Print** on the toolbar and select **Maintain Your Printer**.
   
   A toolbox window opens.
4. From the **Advanced Settings** tab, select **Change** for the Auto-Off option.
5. From the time period list, select one for Auto-Off inactivity time and then click **OK**.

6. Click **Yes** when prompted.

Auto-Off is enabled.

**To manually enable Auto-Off from the printer control panel**

1. On the printer control panel, press the Home button ( HOME ) to display the Home screen.
2. Select **Setup, Printer Settings**, and then **Power Management**.
   To select a function on a screen, use the arrow button ( ) or ( ) to select it, and then press the OK button.
3. Select **Auto-Off**.
4. Choose an inactivity time period from the list, and then press OK.
   A message shows up, prompting you whether to always enable Auto-Off.
5. Select **Yes** by pressing OK.

**Quiet Mode**

Quiet Mode slows down printing to reduce noise while keeping print quality. It only works for printing with normal print quality on plain paper. To return to normal printing speed, turn Quiet Mode off. This mode is off by default.

**NOTE:** Quiet Mode does not work if you print photos or envelopes.

**To turn on Quiet Mode from the printer control panel**

1. On the printer control panel, press the Home button ( HOME ) to display the Home screen.
2. Select **Setup**, and then **Printer Settings**.
   To select a function on a screen, use the arrow button ( ), ( ) to select it, and then press the OK button.
3. Choose **On** for **Quiet Mode**.

**To turn Quiet Mode on or off from the printer software (Windows)**

1. Open the HP printer software. For more information, see [Open the HP printer software (Windows)](###).
2. Click **Quiet Mode** from the toolbar.
3. Select **On** or **Off**, and then click **Save Setting**.
4. Click **OK**.

**To turn Quiet Mode on or off from the printer software (OS X)**

1. Open HP Utility as described in [HP Utility (OS X)](###).
2. Select the printer.
3. Click **Quiet Mode**.
4. Select **On** or **Off**.
5. Click **Apply Now**.
To turn Quiet Mode on or off from the Embedded Web Server (EWS)

1. Open EWS as described in Open the embedded web server.
2. Click the Settings tab.
3. In the Preferences section select Quiet Mode, and then select On or Off.
4. Click Apply.

Optimize Printing Supplies

To optimize printing supplies such as ink and paper, try the following:

- Recycle used original HP cartridges through HP Planet Partners. For more information, visit www.hp.com/recycle.
- Optimize paper usage by printing on both sides of the paper.
- Change the print quality in the printer driver to a draft setting. The draft setting uses less ink.
- Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the life of the cartridges.

Understand the printer parts

This section contains the following topics:

- Front and side view
- Printing supplies area
- Back view

Front and side view

<table>
<thead>
<tr>
<th>1</th>
<th>Power button</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Power light</td>
</tr>
<tr>
<td>3</td>
<td>Battery light:</td>
</tr>
</tbody>
</table>
● Lights up when the battery installed in the printer is charging.
● Blinks when there is an issue with the battery, such as the battery is faulty or is too hot or too cold to charge.

4 Cartridge access door
5 Output slot
6 Control panel
7 Input tray
8 USB host port:
   ● Connects to a USB flash drive so that you can print photos from the drive. For more information on how to print photos from a USB flash drive, see Print photos.
   ● When the printer is turned on, it can also be used to charge a mobile device (such as a smartphone) connected to the USB host port.
9 Paper-width guides
10 Top cover

## Printing supplies area

![Diagram of printing supplies area]

<table>
<thead>
<tr>
<th></th>
<th>Cartridge access door</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Cartridge latch</td>
</tr>
<tr>
<td>3</td>
<td>Cartridge</td>
</tr>
</tbody>
</table>

**NOTE:** Cartridges should be kept inside the printer to prevent print quality issues or printhead damage.
Back view

1 Battery cover
2 Battery status button: Press to show the battery status. For more information, see Check the battery status.
3 USB port:
   - Connects the printer to your computer with the USB cable.
   - Can also be used to charge the battery installed in the printer. For more information on charging the battery, see Charge the battery
4 Power input
5 Security lock slot: Allows you to insert a security cable to lock your printer.

Use the printer control panel

This section contains the following topics:

- Lift the control panel
- Overview of buttons
- Use the Home screen

Lift the control panel

You can use the printer control panel while it is lying flat, or lift it up for easier viewing and use.

To lift up the control panel

1. Open the printer top cover if it is closed.
2. Hold the top of the control panel as shown and lift it up.

Overview of buttons

The following diagram and related table provides a quick reference to the printer control panel features.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control panel: Lets you manage the printer, such as configuring settings, set up network connections, and read the information from the printer.</td>
</tr>
<tr>
<td>2</td>
<td>Control panel display: Displays menu items, setting options, and information from the printer.</td>
</tr>
<tr>
<td>3</td>
<td>Home button: Returns to the Home screen from any other screen.</td>
</tr>
<tr>
<td>4</td>
<td>Back button: Returns to the previous screen.</td>
</tr>
<tr>
<td>5</td>
<td>Cancel button or Selection button: Changes according to what is displayed on the screen.</td>
</tr>
<tr>
<td>6</td>
<td>OK button: Confirms your selection.</td>
</tr>
<tr>
<td>7</td>
<td>Up arrow button: Selects the previous menu option or scroll up the screen.</td>
</tr>
<tr>
<td>Label</td>
<td>Name and Description</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------</td>
</tr>
<tr>
<td>8</td>
<td>Down arrow button: Selects the next menu option or scrolls down the screen.</td>
</tr>
</tbody>
</table>
| 9     | Wireless button: Displays the wireless connection status and settings.  
|       | The wireless light next to the Wireless button is:  
|       | ● On when the printer is connected to a wireless network.  
|       | ● Blinking when the wireless feature is turned on but the printer is not connected to a wireless network.  
|       | ● Off when the wireless feature is turned off. |
| 10    | Wi-Fi Direct button: Displays the Wi-Fi Direct connection status and settings. |
| 11    | Help button: Opens Help Menu when on the Home screen; displays the help for a selected menu option; or provides more information about the current screen. |

### Use the Home screen

The Home screen displays after you press the home button 🏡. It provides a main menu for you to access the functions offered with the printer. By using those functions, you can manage the printer easily, such as configuring the printer, connecting to wireless networks, and checking ink or battery status.

**TIP:** Alternatively, after connecting the printer a computer, you can manage the printer with the printer software installed on the computer. For information about these tools, see Printer management tools.

#### To access a function on the Home screen

1. On the control panel, press the Home button (🏠) to display the Home screen.
2. Scroll through the screen and select a desired function using the arrow buttons (↑, ↓).
3. Press the OK button to confirm your selection.

### Paper basics

The printer is designed to work well with most types of office paper. It is best to test a variety of print paper types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

- Recommended papers for printing
- Order HP paper supplies
- Tips for selecting and using paper
Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

Business documents

- **HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt**
  This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and newsletters. It is heavy weight for an impressive look and feel.

- **HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy**
  These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

- **HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt**
  These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and vivid colors.

- **HP Bright White Inkjet Paper**
  HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

- **HP Printing Paper**
  HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose. It is acid-free for longer lasting documents.

- **HP Office Paper**
  HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It is acid-free for longer lasting documents.
Photo printing

- **HP Premium Plus Photo Paper**

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them right off the printer. The printer supports several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15 cm), and 5 x 7 inches (13 x 18 cm) in two finishes – glossy or soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers exceptional results with professional quality and durability.

- **HP Advanced Photo Paper**

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

- **HP Everyday Photo Paper**

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 inches and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

- **Hagaki paper (for Japan)**

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer.

To learn more details about the supported media, see Specifications.

**Order HP paper supplies**

The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to [www.hp.com](http://www.hp.com). At this time, some portions of the HP website are available in English only.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

**Tips for selecting and using paper**

For the best results, observe the following guidelines.

- Load only one type of paper at a time into the input tray.
- Make sure the paper is loaded correctly.
- Do not overload the input tray.
- To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the input tray:
  - Multipart forms
  - Media that is damaged, curled, or wrinkled
Media with cutouts or perforations
– Media that is heavily textured, embossed, or does not accept ink well
– Media that is too lightweight or stretches easily
– Media that contains staples or clips

Load paper

When loading paper, ensure that paper is properly loaded in the input tray, adjust the paper-width guides till they touch the edges of the paper, and make sure the printer detects the correct paper size. If the detected paper size is incorrect or the paper size or type needs adjustment, change the paper settings in the printer control panel. For more information on changing paper settings, see Change or set paper settings.

- If you are prompted with a message that indicates unknown paper size, follow instructions on the printer control panel display to adjust the paper-width guides and/or change the paper size.
- If the feature to automatically detect paper size is turned off or is not working properly, change the paper size setting from the printer control panel.
- If the feature to automatically detect paper size is turned on, adjust the paper-width guides till they touch the edge of the paper so that the printer can detect the paper width.
- If you are loading custom paper size, adjust the paper-width guides to a width that is closest to the custom width so that the printer can detect the closest width; if need, change the paper size from the printer control panel.

To load standard-size paper

1. Open the top cover and lift the control panel.
2. Slide the two paper-width guides out as far as possible.
3. Insert the paper print-side up and slide the paper-width guides till they fit snugly against the sides of the paper.

Do not use the paper illustrated in the following graphic.

NOTE: Do not load paper while the printer is printing.

To load envelopes

1. Open the top cover and lift the control panel.
2. Slide the two paper-width guides out as far as possible.
3. Insert the envelope print-side up and the long-edge flap on the left or the short-edge flap at the top.

![Image of envelope insertion]

**NOTE:** Do not load envelopes while the printer is printing.

4. Slide the paper-width guides till they fit snugly against the sides of the envelope.

**To load cards and photo paper**

1. Open the top cover and lift the control panel.
2. Slide the two paper-width guides out as far as possible.
3. Insert the paper print-side up and slide the paper-width guides till they fit snugly against the sides of the paper.

**NOTE:** Do not load paper while the printer is printing.

---

**Change or set paper settings**

**To change paper settings from the printer control panel**

1. From the printer control panel, press the Home button ( huis).
2. From the Home screen, select **Setup** and then press **OK**.
3. Select **Printer Settings**, and then press **OK**.
4. Select **Paper Settings**, and then press **OK**.
5. Select the option for paper size or paper type, and then scroll down to select the size or type of the paper loaded.
To turn on or off the feature to automatically detect paper size

1. From the printer control panel, press the Home button ( ).
2. From the Home screen, select Setup and then press OK.
3. Select Printer Settings, and then press OK.
4. Select Preference, and then press OK.
5. Scroll down and select Automatic Paper Size Detection.
6. Select On or Off.

Update the printer

By default, if the printer is connected to a network and Web Services has been enabled, the printer automatically checks for updates.

To update the printer using the printer control panel

1. On the printer control panel, press the Home button ( ) to display the Home screen.
2. Select Setup, Tools, and then Update the Printer.
   To select a function on a screen, use the arrow button ↑ or ↓ to select it, and then press the OK button.

To update the printer using the embedded web server

1. Open the embedded web server (EWS).
   For more information, see Embedded web server.
2. Click the Tools tab.
3. In the Printer Updates section, click Firmware Updates, and then follow the onscreen instructions.

NOTE: If a printer update is available, the printer downloads and installs the update, and then restarts.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen instructions to set up a proxy server. If you do not have the details, contact your network administrator or the person who set up the network.

Use the printer battery

The printer comes with a lithium-ion rechargeable battery, which can be installed at the rear of the printer. To see the location, see Back view.

The battery is also available for purchase as an optional accessory. To make purchase, contact your local dealer or HP sales office, or visit www.hpshopping.com .

Install or replace the battery

To install or replace the battery

1. Turn off the printer and disconnect the power.
2. If the printer control panel is lifted, press it down and close the printer top cover. For more information about the printer parts, see Understand the printer parts.
3. Remove the battery cover from the rear of the printer.

4. If you are replacing the battery, remove the original battery by lifting the latch and releasing the battery.

5. Insert the battery into the battery slot.
   The battery status button is on the upper-right corner of the battery.

6. Reinsert the battery cover.
   To check the battery status, see Check the battery status.

Check the battery status

To check battery status from the battery

▲ Press the battery status button on the battery.
**TIP:** If the battery is installed in the printer, press similar button on the battery cover.

---

To check battery status from the printer control panel

▲ Press the Home button (ⁿ) to display the Home screen, and then select **Battery Status**.

### Battery status

<table>
<thead>
<tr>
<th>Battery status lights</th>
<th>Number of lights</th>
<th>Color of lights</th>
<th>Battery level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
<td>White(Solid)</td>
<td>100%-80%</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>White(Solid)</td>
<td>79%-60%</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>White(Solid)</td>
<td>59%-40%</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>White(Solid)</td>
<td>39%-20%</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>White(Solid)</td>
<td>19%-11%</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>White(Blinking)</td>
<td>10%-1%</td>
</tr>
<tr>
<td>Battery status lights</td>
<td>Number of lights</td>
<td>Color of lights</td>
<td>Battery level</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Off</td>
<td>Not applicable</td>
<td></td>
<td>The battery cannot be detected or is damaged, corrupted, or cannot be charged for some reason.</td>
</tr>
</tbody>
</table>

**Charge the battery**

The battery installed in the printer is charged when the printer is connected to an electrical supply through a power cable.

Charging the battery using AC power can take up to 2.5 hours. If AC power is removed and the printer is turned off, the battery can also be charged when the USB port on the rear of the printer is connected to the charging USB port of another device. The charging USB port must be able to supply a minimum of 1A.

For example:
- USB charging port on a notebook computer (identified by a lightning symbol near the host port)
- USB charger that is connected to a wall outlet (can be generic or one used for mobile phones or tablets)
- USB charger that is connected to the power port in a car (can be generic or one used for mobile phones or tablets)

**Store the battery**

⚠️ **WARNING!** To avoid potential safety issues, use only the battery provided with the printer or the battery purchased as an accessory from HP.

To make purchases, contact your local dealer or HP sales office, or visit [www.hpshopping.com](http://www.hpshopping.com).

⚠️ **CAUTION:** To prevent damage to a battery, do not expose it to high temperatures for extended periods of time.

**CAUTION:** If the printer is unused and disconnected from external power for more than two weeks, remove the battery and store it separately.

**CAUTION:** To prolong the charge of a stored battery, place it in a cool, dry place.

**Dispose the used battery**

⚠️ **WARNING!** To reduce the risk of fire or burns, do not disassemble, crush, or puncture a battery; short the external contacts on a battery; or dispose of a battery in fire or water. Do not expose a battery to temperatures above 60°C (140°F).

**Open the HP printer software (Windows)**

After installing the HP printer software, depending on your operating system, do one of the following.
- **Windows 10**: From the computer desktop, click the Start button, click **All apps**, select **HP**, and then select the icon with the printer name.
- **Windows 8.1**: Click the down arrow in lower left corner of the **Start** screen, and then select the icon with the printer name.
- **Windows 8**: On the **Start** screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then select the icon with the printer name.
- **Windows 7, Windows Vista, and Windows XP**: From the computer desktop, click the Start button, select **All Programs**, select **HP**, select the folder for the printer, and then select the icon with the printer name.
3 Print

With this printer, you can print various medias such as documents, brochures, photos and envelopes from either computers, USB flash drives, or mobile devices (smart phones or tablets).

To print documents and photos from mobile devices (such as smart phones or tablets), visit the HP Mobile Printing website at [www.hp.com/go/mobileprinting](http://www.hp.com/go/mobileprinting). If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing site in another country/region or language.

**NOTE:** Most print settings are automatically handled by the software application. Change the settings manually only when you want to change print quality, print on specific types of paper, or use special features.

**TIP:** This printer includes HP ePrint, a free service from HP that allows you to print documents on an HP ePrint-enabled printer anytime, from any location, without any additional software or printer drivers. For more information, see Print with HP ePrint.

- Print documents
- Print brochures
- Print on envelopes
- Print photos
- Print on special and custom-size paper
- Print on both sides
- Print with AirPrint™
- Tips for print success

### Print documents

**To print documents (Windows)**

1. Load paper in the tray. For more information, see Load paper.
2. From the File menu in your software, select Print.
   
   A Print window opens.
3. In the window, select your printer.
4. Specify the page range and the number of copies you want to print.
5. Click the button that opens the Properties window to set up the layout and print quality on the pages.
   
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.

**NOTE:** To set print settings for all print jobs, make the changes in the HP software. For more information on the HP software, see Printer management tools.
6. Click OK to confirm the setups, and the Properties window closes.
7. Click Print or OK to begin printing.

To print documents (OS X)

1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Set the print options.

If you do not see options on the Print dialog, click Show Details.
   - Choose the appropriate paper size in the Paper Size pop-up menu.

   **NOTE:** If you change the paper size, ensure that you have loaded the correct paper.
   - Select the orientation.
   - Enter the scaling percentage.
4. Click Print.

Print brochures

To print brochures (Windows)

1. Load paper in the tray. For more information, see Load paper.
2. From the File menu in your software, select Print.

   A Print window opens.
3. In the window, select your printer.
4. Specify the page range and the number of copies you want to print.
5. Click the button that opens the Properties window.

   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.

   **NOTE:** To set print settings for all print jobs, make the changes in the HP software. For more information on the HP software, see Printer management tools.
6. From the Printing Shortcut tab in the Properties window, select a brochure type from the Paper Type drop-down menu.
7. From the other two tabs in the window, set the layout and print quality on the pages.
8. Click OK to confirm the setups. The Properties window closes.
9. Click Print or OK to begin printing.

To print brochures (OS X)

1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Set the print options.

   If you do not see options on the Print dialog, click Show Details.
a. Choose the appropriate paper size in the **Paper Size** pop-up menu.

**NOTE:** If you change the paper size, ensure that you have loaded the correct paper.

b. From the pop-up menu, choose **Paper Type/Quality**, and then choose the option that provides the best quality or maximum dpi.

4. Click **Print**.

### Print on envelopes

**To print envelopes (Windows)**

1. Load envelopes in the tray. For more information, see **Load paper**.
2. From the **File** menu in your software, select **Print**.
   
   A **Print** window opens.
3. In the window, select your printer.
4. Specify the number of copies you want to print.
5. Click the **Page Setup** button to open the **Page Setup** window.
6. Choose the **Landscape** orientation.
7. From the **Paper** tab, choose an envelope type from the **Paper size** drop-down menu.
8. Click **OK** to close the window.
9. Click **Print** or **OK** to begin printing.

**To print envelopes (OS X)**

1. From the **File** menu in your software, choose **Print**.
2. Make sure your printer is selected.
3. Select the appropriate envelope size from the **Paper Size** pop-up menu.
   
   If you do not see options on the Print dialog, click **Show Details**.

   **NOTE:** If you change the paper size, ensure that you have loaded the correct paper.

4. From the pop-up menu, choose **Paper Type/Quality**, and verify the paper type setting is set to **Plain Paper**.
5. Click **Print**.

### Print photos

You can print a photo from either a computer or a USB flash drive. However, an encrypted USB flash drive is not supported.

Photo paper must be flat before printing. Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair the quality of your printout.

**CAUTION:** Do not remove the flash drive from the printer USB port while it is being accessed by the printer, which can damage the files on the drive.
To print a photo from the computer (Windows)

1. Load paper in the tray. For more information, see Load paper.
2. From your software, select Print to open a print window.
3. Make sure your printer is selected.
4. Specify the number of copies you want to print.
5. Click the button that opens the Properties window.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.

   **NOTE:** Detailed settings are described in Tips for print success.
6. From this window, select the color, layout, print quality, and paper type for the printout.
7. Click OK to close the Properties window.
8. Click Print or OK to begin printing.

To print a photo from the computer (OS X)

1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Set the print options.
   If you do not see options on the Print dialog, click Show Details.
   - Choose the appropriate paper size in the Paper Size pop-up menu.
   
   **NOTE:** If you change the paper size ensure that you have loaded the correct paper.
   - Select the orientation.
4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:
   - Paper Type: The appropriate photo paper type
   - Quality: Select the option that provides the best quality or maximum dpi.
   - Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix option.
     – Off: applies no changes to the image.
     – On: automatically focuses the image; moderately adjusts image sharpness.
5. Select any other print settings you want, and then click Print.

To print photos from a USB flash drive

You can print a photo from a USB flash drive directly without using a computer.

**NOTE:** Only photo files in the format of PNG, JPG, and TIFF can be printed. All the other files cannot be printed.

1. Insert a USB flash drive into the USB host port on the right side of the printer.
2. Wait for the files and folders on the flash driver to display on the control panel screen.
   Folders and photo files in the format of JPG, PNG, and TIFF on the flash driver will be displayed.
3. Locate the desired photo by pressing the arrow button ▲ or ▼, and then press the OK button.
   Alternatively, you can search for a desired photo using the button ▶ and the OK button.

NOTE: To return to the previous screen, use the Return button ◀.

4. Select the print color (color or black), the number of print copies, and the paper type respectively from the Image Print screen.

5. Press OK to begin printing.

Print on special and custom-size paper

If your application supports custom-size paper, set the size in the application before printing the document. If not, set the size in the printer driver. You might need to reformat existing documents to print them correctly on custom-size paper.

To set up custom sizes (Windows)

1. Depending on your operating system, do one of the following:
   - Windows 10: From the Windows Start menu, click All apps, select Windows System, and then click Devices, select Devices and printers under Related settings menu. Select the printer name, and select Print server properties.
   - Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers. Click or tap the printer name, and click or tap Print server properties.
   - Windows 7: From the Windows Start menu, click Devices and Printers. Select the printer name, and select Print server properties.
   - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers. Right-click an empty area in the Printers window, and select Server Properties.
   - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes. From the File menu, click Server Properties.

2. Select the Create a new form check box.

3. Enter the name of the custom size paper.

4. Enter the dimensions of the custom size in the Form description (measurements) section.

5. Click Save Form, and then click Close.

To print on special or custom-size paper (Windows)

NOTE: Before you can print on custom-size paper, you must set up the custom size in the Print Server Properties.

1. Load the appropriate paper in the tray. For more information, see Load paper.

2. From the File menu in your software application, click Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
NOTE: To set print settings for all print jobs, make the changes in the HP software. For more information on the HP software, see Printer management tools.

5. On the **Layout** tab or **Paper/Quality** tab, click the **Advanced** button.

6. In the **Paper/Output** area, select the custom size from the **Paper Size** drop-down list.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the paper size on the printer control panel.

7. Select any other print settings that you want, and then click **OK**.

8. Click **Print** or **OK** to begin printing.

**To print on special or custom-size paper (OS X)**

Before you can print on custom-size paper, you must set up the custom size in the HP software.

1. Load the appropriate paper in the tray.

2. Create the new custom paper size.
   a. In the software you want to print from, click **File**, and then click **Print**.
   b. Make sure your printer is selected.
   c. Click **Manage Custom Sizes** in the **Paper Size** pop-up menu.
      If you do not see options on the Print dialog, click **Show Details**.
   d. Click **+**, and then select the new item in the list and type a name for the custom paper size.
   e. Enter the height and width for your custom paper.
   f. Click **Done** or **OK**, and then click **Save**.

3. Use the created custom paper size to print.
   a. From the **File** menu in your software application, click **Print**.
   b. Make sure your printer is selected.
   c. Choose the custom paper size name you created in the **Paper Size** pop-up menu.
   d. Select any other print settings you want, and then click **Print**.

**Print on both sides**

**To print on both sides (Windows)**

To print on both sides, you must do it manually. Automatic duplexing is not supported with this printer.

1. Load paper in the tray. For more information, see **Load paper**.

2. From the **File** menu in your software, select **Print**.
   A **Print** window opens.

3. Select your printer.

4. Specify the page range and the number of copies you want to print.
5. Click the button that opens the **Properties** window. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer Properties**, **Printer**, or **Preferences**.

**NOTE:** To set print settings for all print jobs, make the changes in the HP software. For more information on the HP software, see **Printer management tools**.

6. From the **Layout** tab, choose either **Flip on Long Edge** or **Flip on Short Edge** from the **Print on Both Sides Manually** drop-down list.

7. To choose the page size, on the **Paper/Quality** tab, click the **Advanced** button, and then choose a proper size from the **Paper Size** drop-down list.

8. Configure the other settings from the three tabs, **Layout**, **Paper/Quality**, and **Printing Shortcut**. For details, see the "Printer settings tips (windows)" section in **Tips for print success**.

9. Click **OK** to close the **Properties** window.

10. Click **Print** or **OK** to begin printing.

11. After one side is printed, follow onscreen instructions to reload the paper back into the input tray.

12. Click **Continue** in the onscreen instructions to print the other side of the paper.

**To print on both sides of the page (OS X)**

1. From the **File** menu in your software, choose **Print**.

2. In the Print dialog, choose **Paper Handling** from the pop-up menu and set **Page Order** to **Normal**.

3. Set **Pages to Print** to **Odd Only**.

4. Click **Print**.

5. After all of the odd numbered pages have printed, remove the document from the output tray.

6. Reload the document so that the end that came out of the printer is now going into the printer and the blank side of the document is facing toward the front of the printer.

7. In the Print dialog, return to the **Paper Handling** pop-up menu and set the page order to **Normal** and the pages to print to **Even Only**.

8. Click **Print**.

**Print with AirPrint™**

Printing using Apple’s AirPrint is supported for iOS 4.2 and Mac OS X 10.7 or later. Use AirPrint to print wirelessly to the printer from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following mobile applications:

- Mail
- Photos
- Safari
- Supported third-party applications, for example Evernote
To use AirPrint, ensure the following:

- The printer must be connected to the same network as your AirPrint enabled device. For more information about using AirPrint and about which HP products are compatible with AirPrint, visit the HP Mobile Printing website at www.hp.com/go/mobileprinting. If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing site in another country/region or language.

- Load paper that matches the paper settings of the printer (see Load paper for more information). Accurately setting the paper size for the paper that is loaded, enables a mobile device to know what paper size it is printing.

**Tips for print success**

**Ink tips**

- If the print quality is not acceptable, see Printing issues for more information.

- Use Original HP cartridges.

  Original HP cartridges are designed and tested with HP printers and papers to help you easily produce great results, time after time.

  **NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

  If you believe you purchased Original HP cartridges, go to www.hp.com/go/anticounterfeit.

- Install both the black and color cartridges correctly.

  For more information, see Replace the cartridges.

- Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

  Ink level warnings and indicators provide estimates for planning purposes only.

  For more information, see Check the estimated ink levels.

**Paper loading tips**

For more information, see Load paper.

- Ensure the paper is properly loaded in the input tray and then adjust the paper-width guides. Change the paper settings if the paper size is not correctly detected.

- Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type to avoid a paper jam.

- Load paper with the print-side up.

- Ensure that the edges of the paper loaded in the input tray are not bent or torn.

- Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do not bend the paper in the tray.
Printer settings tips (Windows)

- To change default print settings, click **Print**, and then click **Set Preferences** in the HP printer software. Open the HP printer software. For more information, see Open the HP printer software (Windows).
- To select the number of pages to print per sheet, on the **Layout** tab of the printer driver, select the appropriate option from the **Pages per Sheet** drop-down list.
- If you want to change the page orientation, set it in your application interface.
- To view more printing settings, on the **Layout** or **Paper/Quality** tab of the printer driver, click the **Advanced** button to open the **Advanced Options** dialog box.

**NOTE:** The preview on the **Layout** tab cannot reflect what you select from the **Pages per Sheet Layout**, the **Booklet**, or the **Page Borders** drop-down lists.

- **Print in Grayscale**: Allows you to print a black and white document using the black ink only. Select **Black Ink Only**, and then click the **OK** button.
- **Pages per Sheet Layout**: Helps you specify the order of the pages if you print document in more than two pages per sheet.
- **Borderless Printing**: Select this feature to print photos without border. Not all paper types support this feature. You will see an alert icon beside the option if the selected paper type in the **Media** drop-down list does not support it.
- **HP Real Life Technologies**: This feature smooths and sharpens images and graphics for improved print quality.
- **Booklet**: Allows you to print a multiple-page document as a booklet. It places two pages on each side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding method from the drop-down list, and then click **OK**.
  - **Booklet-LeftBinding**: The binding side after folded into a booklet appears at the left side. Select the option if your reading habit is from left to right.
  - **Booklet-RightBinding**: The binding side after folded into a booklet appears at the right side. Select the option if your reading habit is from right to left.
- **Page Borders**: Allows you to add the borders to the pages if you print the document with two or more pages per sheet.

- You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the setting values that are appropriate for a particular kind of job, so that you can set all the options with a single click. To use it, go to the **Printing Shortcut** tab, select one printing shortcut, and then click **OK**.

  To add a new printing shortcut, after making settings on the **Layout** or **Paper/Quality** tab, click the **Printing Shortcut** tab, click **Save As** and enter a name, and then click **OK**.

  To delete a printing shortcut, select it, and then click **Delete**.

**NOTE:** You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

- On the Print dialog, use the **Paper Size** pop-up menu to select the size of paper loaded in the printer.
- On the Print dialog, choose the **Paper Type/Quality** pop-up menu and select the appropriate paper type and quality.
Print with HP ePrint

HP ePrint is one of the HP supplied web services. The printer with the HP ePrint capability can print documents or photos from any located computer or mobile device.

After you email documents and photos to the email address assigned to the printer, the printer will start to print.

**NOTE:** This feature works only if the printer is connected to Internet via a wireless network.

This section contains the following topics:

- Set up HP ePrint
- Print with HP ePrint

Set up HP ePrint

Before the setup, make sure your printer is connected to Internet via a wireless network.

**Use the control panel to set up HP ePrint**

1. On the printer control panel, press the Home button (🏠) to display the Home screen.
2. Select **HP ePrint** using the arrow buttons (↑, ↓), and then press the OK button.
3. Follow the onscreen instructions.

   The printer starts checking for and installing updates.

   **NOTE:** If prompted for proxy settings and if your network uses proxy settings, follow the on-screen instructions to set up a proxy server. If you do not have the proxy details, contact your network administrator or the person who set up the network.

4. Press OK to accept the terms of use when prompted.

   When the printer connects to the server, the printer prints an information page.

5. Follow the instructions on the page to complete the setup.

6. Follow the instructions below to find out the **HP ePrint** email address assigned to the printer.
   
   **a.** Press the Home button (🏠) to return to the Home screen.
   
   **b.** Select **HP ePrint**, and then **Print Info**.

   The printer starts to print an information page. Follow the instructions on it to customize the email address.

**TIP:** For more information about managing and configuring **HP ePrint** settings and to learn about the latest features, visit HP Connected at [www.hpconnected.com](http://www.hpconnected.com). This site might not be available in all countries/regions.
Print with HP ePrint

You can use this feature to print files when you are far away from the printer.

Before you begin

You must make sure:

- Your printer has already connected to Internet via a wireless network and has set up HP ePrint. To learn the setups, see Set up HP ePrint.
- Your computer or mobile device has already connected to a network.

Procedure

1. On your computer or mobile device, open the email application.
2. Create a new email and attach the file you want to print.
3. In the “To” field, enter the email address of the printer, and then send the email.

For how to know the email address of the printer, see Set up HP ePrint.

NOTE: Do not enter any additional email addresses in either the “To” or “Cc” fields. The HP ePrint server does not accept print jobs if there are multiple email addresses.
5 Work with cartridges

This section contains the following topics:
- Information on cartridges and the printhead
- Check the estimated ink levels
- Printing with black or color ink only
- Replace the cartridges
- Order cartridges
- Store printing supplies
- Cartridge warranty information

Information on cartridges and the printhead

The following tips help maintain HP cartridges and ensure consistent print quality.
- The instructions in this user guide are for replacing cartridges, and are not intended for first time installation. For the first time installation, follow the instructions in the setup poster provided with the printer.
- When you turn the printer off, always use (the Power button). This allows the printer to cap the printhead and protect it from damage.
- Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.
- Handle cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary printing problems.
- If you are transporting the printer, do the following to prevent ink leaking from the printer or other damage from occurring to the printer:
  - Make sure you turn off the printer by pressing (the Power button). Wait until all sounds of internal motion stop before unplugging the printer.
  - The printer must be transported sitting flat; it should not be placed on its side, back, front, or top.

Check the estimated ink levels

You can check the estimated ink levels from the printer software or from the printer control panel.

To check the ink levels from the printer control panel

1. On the printer control panel, press the Home button ( ) to display the Home screen.
2. Select Ink Information using arrow buttons ( or ), and then press the OK button.
3. Select Estimated Ink Levels, and then press OK.
To check the ink levels from HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. In the printer software, click Estimated Ink Levels.

To check the ink levels from the HP printer software (OS X)

1. Open HP Utility.

   HP Utility is located in the HP folder in the Applications folder at the top level of the hard disk.

2. Select the printer from the Devices list.

3. Click Supplies Status.

   The estimated ink levels appear.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/inkusage.

Printing with black or color ink only

For regular usage, this product is not designed to print using only one cartridge. However, when one cartridge runs out of ink, you can remove it and use the other cartridge to continue printing.

The printer supports this capability only if the cartridge has sufficient ink. Therefore, you should replace the empty cartridge as soon as possible.

Replace the cartridges

If you do not already have spare cartridges, see Order cartridges. Not all cartridges are available in all countries/regions.

⚠️ CAUTION: HP recommends that you install any missing cartridges as soon as possible to avoid print quality issues and possible extra ink usage or damage to the ink system.

For information on recycling used ink supplies, see HP inkjet supplies recycling program.

☀️ TIP: The printer supports single cartridge mode. For more information, see Printing with black or color ink only.

To replace the cartridges

1. Make sure the printer is turned on.
2. Open the cartridge access door and wait for the print carriage to stop moving.

**CAUTION:** Do not replace or install cartridges when the print carriage is still moving.

3. Open the cartridge latch as shown and gently remove the cartridge from its slot.

4. Remove the protective film from a new cartridge.

5. Insert the new cartridge, and then close the latch as illustrated.

**NOTE:** Install the color cartridge on the left and the black cartridge on the right.

6. Repeat steps 3 through 5 for the other cartridge if needed.

7. Close the cartridge access door.
Order cartridges

To order cartridges, go to [www.hp.com](http://www.hp.com). (At this time, some portions of the HP website are available in English only.) Ordering cartridges online is not supported in all countries/regions. However, many countries have information on ordering by telephone, locating a local store, and printing a shopping list. In addition, you can visit the [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies) page to obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the cartridge you are replacing. You can find the cartridge number in the following places:

- On the label of the cartridge you are replacing.
- On a sticker inside the printer. Open the cartridge access door to locate the sticker.
- In the printer software, click **Shop**, and then click **Shop For Supplies Online**.
- In the embedded web server, by clicking the **Tools** tab, and then, under **Product Information** clicking **Ink Gauge**. For more information, see [Embedded web server](http://www.hp.com).

Store printing supplies

- Keep all cartridges in the original sealed packages until they are needed.
- Cartridges can be left in the printer for extended periods of time. However, to assure optimal cartridge health, be sure to turn off the printer properly by pressing (the Power button).
- Store cartridges at room temperature (15-35° C or 59-95° F).

Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the ink product.
6  Network setup

Additional advanced settings are available from the printer’s home page (embedded web server or EWS). For more information, see Open the embedded web server.

This section contains the following topics:

- Set up the printer for wireless communication
- Change network settings
- Use Wi-Fi Direct

Set up the printer for wireless communication

- Before you begin
- Set up the printer on your wireless network
- Change the connection type
- Test the wireless connection
- Turn on or off the wireless capability of the printer

**NOTE:** If you encounter problems connecting the printer, see Network and connection issues.

**TIP:** For more information about setting up and using the printer wirelessly, visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting.

Before you begin

Ensure the following:

- The wireless network is set up and working properly.
- The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless password.

- The wireless network name is the name of your wireless network.
- The wireless password prevents other people from connecting to your wireless network without your permission. Depending on the level of security required, your wireless network might use either a WPA passphrase or WEP key.

If you have not changed the network name or the security passkey since setting up your wireless network, you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security password or cannot remember this information, see the documentation provided with your computer or with the wireless router. If you still cannot find this information, contact your network administrator or the person who set up the wireless network.

Set up the printer on your wireless network

Use the Wireless Setup Wizard from the printer control panel display to set up wireless communication.
NOTE: Before you proceed, go through the list at Before you begin.

1. On the printer control panel, press the Home button (走去) to display the Home screen.
   The printer starts searching for the available wireless networks.
   To select a function on a screen, use the arrow button (▲, ▼) to select it, and then press the OK button.
3. From the list, select the wireless network shared with your computer or mobile device.
   The printer starts connecting to the network. When it connects, you see a message indicating success
   and connection information.
   If you encounter problems connecting the printer, see Network and connection issues.
4. Press OK to return to the Wireless Settings screen. You will see the wireless is already turned on.
   For more information about setting up and using the printer wirelessly, visit the HP Wireless Printing
   Center www.hp.com/go/wirelessprinting.
   If you are already using the printer with a different type of connection, such as a USB connection, follow the
   instructions in Change the connection type to set up the printer on your wireless network.

Change the connection type

After you have installed the HP printer software, you can use this software to change the connection type
from a USB connection to a wireless connection or vice versa.

To change from a USB connection to a wireless network (Windows)

Before you proceed, go through the list at Before you begin.
1. Open the HP printer software. For more information, see Open the HP printer software (Windows).
2. Click Tools.
3. Click Device Setup & Software.
4. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.

To change from a USB connection to a wireless network (OS X)

1. Connect the printer to your wireless network.
2. Use 123.hp.com to change the software connection to wireless for this printer.

   Learn more about how to change from a USB to wireless connection. Click here to go online for more
   information. At this time, this website might not be available in all languages.

To change from a wireless connection to a USB connection

- Connect the printer and the computer with the provided USB cable. This USB port is at the rear of the
  printer. For the specific location, see Back view.

Test the wireless connection

Print the wireless test report for information about the printer wireless connection. The wireless test report
provides information about the printer status, hardware (MAC) address, and IP address. If there is a problem
with the wireless connection or if a wireless connection attempt failed, the wireless test report also provides diagnostic information. If the printer is connected to a network, the test report displays details about the network settings.

**To print the wireless test report**

1. From the printer control panel, press the wireless button.
   The printer wireless connection status and the network settings are displayed on the screen.
2. On the printer control panel, press the Home button to display the Home screen.
3. Select Network, then Print Reports, and then select Test Reports.
   To select a function on a screen, use the arrow button (▲, ▼) to select it, and then press the OK button.

**Turn on or off the wireless capability of the printer**

Before you proceed, you can check the wireless status of the printer by pressing (the Wireless button) on the control panel.

**To turn on or off the wireless capability**

1. On the printer control panel, press the Home button to display the Home screen.
2. Select Network, and then select Wireless Settings.
   To select a function on a screen, use the arrow button (▲, ▼) to select it, and then press the OK button
3. Select Wireless, and then select On or Off.

**Change network settings**

From the printer control panel, you can set up and manage your printer's wireless connection and perform a variety of network management tasks. This includes viewing and changing network settings, restoring network defaults, and turning the wireless function on or off.

⚠️ **CAUTION:** Network settings are provided for your convenience. However, unless you are an advanced user, you should not change some of these settings (such as IP settings, default gateway and firewall settings).

**To print network settings report**

▲ From the printer control panel, select Setup, select Reports, and then select Network Configuration Page.

**To change IP settings**

The default IP setting for the IP settings is Automatic, which sets the IP settings automatically. If you are an advanced user and want to use different settings (such as the IP address, subnet mask, or the default gateway), you can change them manually.

⭐ **TIP:** Before setting a manual IP address, it is recommended to first connect the printer to the network using Automatic mode. This allows the router to configure the printer with other needed settings like subnet mask, default gateway and DNS address.

⚠️ **CAUTION:** Be careful when manually assigning an IP address. If you enter an invalid IP address during the installation, your network components cannot connect with the printer.
1. From the printer control panel, select **Network**

2. Select **Wireless Settings**.

3. Select **Advanced Settings**.

4. Select **IP Settings**.

   A message appears warning that changing the IP address removes the printer from the network. Press **OK** to continue.

5. To change the settings manually, select **Manual (Static)**, and then enter the appropriate information for the following settings:
   - IP Address
   - Subnet Mask
   - Default Gateway
   - DNS Address

6. Enter your changes, and then select **Apply**.

**Use Wi-Fi Direct**

Wi-Fi Direct lets you print wirelessly from a computer or a wireless-capable mobile device without connecting to a wireless network.

**NOTE:** When using the HP printer software to connect your printer to a computer, choosing the wireless connection stores the Wi-Fi Direct profile of the printer into the computer after the connection successes. The Wi-Fi Direct name is added into the wireless network list on the computer.

**Guidelines for using Wi-Fi Direct**

- Make sure your computer or mobile device has the necessary software.
  - If you are using a computer, make sure you have installed the HP printer software.
    - If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and then install the printer software.
  - If you are using a mobile device, make sure you have installed a compatible printing app. For more information about mobile printing, visit the HP Mobile Printing website at [www.hp.com/go/mobileprinting](http://www.hp.com/go/mobileprinting). If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing site in another country/region or language.
- Make sure Wi-Fi Direct for your printer is turned on.
- Up to five computers and mobile devices can use the same Wi-Fi Direct connection.
- Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to a network using a wireless connection.
- Wi-Fi Direct cannot connect a computer, mobile device, or printer to the Internet.
To turn on Wi-Fi Direct

1. On the printer control panel, press the Wi-Fi Direct button.

The Wi-Fi Direct connection status and details are displayed.

2. Press the button to select Settings.

3. Choose On for the Wi-Fi Direct item.

To print from a wireless-capable mobile device that supports Wi-Fi Direct

You must download and enable the HP Print Service Plugin (supported by most Android devices) from the Google Play Store.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with the mobile device.

3. From your mobile device, select a document from a print enabled application, and then select the option to print the document.

   The list of available printers appears.

4. 

5. Connecting to the printer using Wi-Fi Direct.

   ● If Automatic was selected during Wi-Fi Direct setup on the printer, the mobile device automatically connects to the printer.

   ● If Manual was selected during Wi-Fi Direct setup on the printer, acknowledge the connection on the printer display, or enter the printer PIN on your mobile device.

   The PIN is provided by the printer when a connection attempt is made.

6. Print your document.

To print from a wireless-capable mobile device that does not support Wi-Fi Direct

Make sure you have installed a compatible printing app on your mobile device. For more information, visit the HP Mobile Printing website at www.hp.com/go/mobileprinting. If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing site in another country/region or language.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation provided with the mobile device.

   ✔️ NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such as DIRECT-**-HP OfficeJet XXXX (where ** are the unique characters to identify your printer and XXXX is the printer model located on the printer).

   Enter the Wi-Fi Direct password when prompted.

4. Print your document. For more information about print, see Print.
To print from a Wi-Fi Direct capable computer (Windows)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the computer’s Wi-Fi connection. For more information, see the documentation provided with the computer.

   **NOTE:** If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such as **DIRECT-****-HP OfficeJet XXXX** (where ** are the unique characters to identify your printer and XXXX is the printer model located on the printer).

   Enter the Wi-Fi Direct password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless network. If the printer has been installed and connected to your computer with a USB cable, follow the steps below to install the printer software using the Wi-Fi Direct connection.

   a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

   b. Click **Tools**.

   c. Click **Device Setup & Software**, and then select **Connect a new printer**.

      **NOTE:** If you have previously installed the printer over USB and want to convert to Wi-Fi Direct, do not select the **Convert a USB connected printer to wireless** option.

   d. When the **Connection Options** software screen appears, select **Wireless**.

   e. Select your HP printer from the detected printer list.

   f. Follow the onscreen instructions.

5. Print your document. For more information about print, see **Print**.

To print from a Wi-Fi Direct capable computer (OS X)

1. Make sure the printer enables Wi-Fi Direct.

2. Turn on Wi-Fi on the computer.

   For more information, see the documentation provided by Apple.

3. Click the Wi-Fi icon and choose the Wi-Fi Direct name, such as **DIRECT-****-HP OfficeJet XXXX** (where ** are the unique characters to identify your printer and XXXX is the printer model located on the printer).

4. If Wi-Fi Direct is turned on with security, enter the password when prompted.

5. Print your document. For more information about print, see **Print**.

   **NOTE:** If you have previously installed the printer over USB and want to convert to Wi-Fi Direct, do not select the **Convert a USB connected printer to wireless** option.

   **Click here for online troubleshooting for Wi-Fi Direct, or for more help with setting up Wi-Fi Direct. At this time, this website might not be available in all languages.**
7 Printer management tools

This section contains the following topics:

- Toolbox (Windows)
- HP Utility (OS X)
- Embedded web server

Toolbox (Windows)

The Toolbox provides maintenance information about the printer.

To open the Toolbox

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).
2. Click Print.
3. Click Maintain Your Printer.

HP Utility (OS X)

HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only.

Double-click HP Utility in the HP folder in the Applications folder at the top level of the hard disk.

Embedded web server

When the printer is connected to a network, you can use the printer’s embedded web server (EWS) to view status information, change settings, and manage it from your computer.

NOTE: To view or change some settings, you might need a password.

NOTE: You can open and use the embedded web server without being connected to the Internet. However, some features are not available.

- About cookies
- Open the embedded web server
- Embedded web server cannot be opened

About cookies

The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have configured the EWS language, a cookie helps remember which language you have selected so that the next
time you access the EWS, the pages are displayed in that language. Some cookies (such as the cookie that stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:

- Using some setup wizards
- Remembering the EWS browser language setting
- Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see the documentation available with your Web browser.

**Open the embedded web server**

You can access the embedded web server through either a network or Wi-Fi Direct.

**To open the embedded web server through a wireless network**

1. Make sure both your printer and computer are connected to the same wireless network.
2. From the printer control panel, press the wireless button to find out the IP address or hostname of the printer.
3. Type such IP address or hostname in a supported web browser on your computer.
   
   For example, if the IP address is 123.123.123.123, type the following address into the web browser:
   
   `http://123.123.123.123`

**To open the embedded web server through Wi-Fi Direct**

1. From the printer control panel, press the Wi-Fi Direct button.
2. Skip this step if the display shows the Wi-Fi Direct is on.
   
   Press the button to select Settings, and then choose On for the Wi-Fi Direct option.
3. From your wireless computer, turn wireless on, search for and connect to the Wi-Fi Direct name, for example: DIRECT-**-HP OfficeJet XXXX (where ** are the unique characters to identify your printer and XXXX is the printer model located on the printer).
4. Enter the Wi-Fi Direct password when prompted on your computer.
5. In a supported web browser on your computer, type the following IP address of the printer:
   
   `http://192.168.223.1`

**Embedded web server cannot be opened**

**Check your network**

1. Restart your network router.
2. Wait until your computer and network have both reconnected to the network successfully.
3. Access the printer’s EWS again.
Check the computer

- Make sure the computer that you are using is connected to the network.

**NOTE:** You may also access the printer’s EWS if the computer is connected to the printer through Wi-Fi Direct. For information about how to access EWS through Wi-Fi Direct, see Open the embedded web server.

Check your web browser

- Make sure the web browser meets the minimum system requirements.
- If your web browser uses any proxy settings to connect to the Internet, try turning off these settings. For more information, see the documentation available with your web browser.
- Make sure JavaScript and cookies are enabled in your web browser. For more information, see the documentation available with your web browser.

Check the printer IP address

- To check the IP address of the printer, you can print a wireless test report. For more information about the wireless test report, see Test the wireless connection.
- Ping the printer using the IP address from the command prompt (Windows) or from Network Utility (OS X).

**NOTE:** To find Network Utility from OS X, click the icon Spotlight, and then type Network Utility into the search field.

For example, if the IP address is 123.123.123.123, type the following at the command prompt (Windows):

C:\ping 123.123.123.123

Or

In Network Utility (OS X), click the Ping tab, type the 123.123.123.123 in the box, and then click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is incorrect.

**TIP:** If you are using a computer running Windows, you can visit the HP online support website at www.hp.com/support. This website provides information and utilities that can help you correct many common printer problems.
8 Solve a problem

The information in this section suggests solutions to common problems. If your printer is not operating correctly and these suggestions did not solve your problem, try using one of the support services listed in HP support to obtain assistance.

This section contains the following topics:
- Jams and paper-feed issues
- Printing issues
- Network and connection issues
- Printer hardware issues
- Get help from the printer control panel
- Understand printer reports
- Solve problems using HP ePrint
- Maintain the printer
- Restore defaults and settings
- HP support

Jams and paper-feed issues

What do you want to do?

Clear a paper jam

<table>
<thead>
<tr>
<th>Solve paper jam issues</th>
<th>Use an HP online troubleshooting wizard.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Instructions for clearing paper jam and resolving issues with paper or the paper feed.</td>
</tr>
</tbody>
</table>

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Instructions on clearing paper jams

Paper jams can occur in several locations inside the printer. You must clear the paper jams as soon as possible in case the printhead is damaged.

To clear a paper jam

1. Remove paper that is not jammed from both the input tray and output slot.
2. If paper is jammed in the input tray or output slot, slowly and steadily pull it out to avoid paper tear.
   - If you cannot remove it, it should be jammed in the printing area. Go through next steps.
3. Open the cartridge access door.
4. Remove all visible paper by moving the cartridges around from one side to the other.
   If you still fail to remove, use **HP online troubleshooting wizard** to resolve the cartridge jams.
5. Close the cartridge access door.
6. Check to make sure all jammed and torn pieces of paper are cleared. Otherwise, more paper jams will occur.
7. (Option) If the cartridges did not return to the home position at the left side of the printer, turn the printer off and on again.

**Learn how to avoid paper jams**

To help avoid paper jams, follow these guidelines.

- Remove printed papers from the output slot frequently.
- Make sure that you are printing with paper that is not wrinkled, folded, or damaged.
- Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
- Do not use paper that is too thick or too thin for the printer.
- Make sure that the paper is loaded correctly. For more information, see **Load paper**.
- Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
- Do not place too much paper in the input tray. For information on the maximum number of sheets allowed in the input tray, see **Specifications**.
- When loading a stack of paper, fan the pages first.
- Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray must be the same size and type.
- Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the paper-width guides do not bend the paper in the input tray.
- Do not force paper too far inside the input tray.
- If you are printing on both sides of a page, do not print highly saturated images on light weight paper.
- Use paper types that are recommended for the printer.
- If the printer is about to run out of paper, allow the printer to run out of paper first, and then add paper. Do not load paper when the printer is printing.

**Solve paper-feed problems**

What kind of problem are you having?

- **Paper is not picked up from the input tray**
– Make sure paper is loaded in the input tray. For more information, see Load paper. Fan the paper before loading.
– Make sure the paper-width guides are snug, but not tight, against the paper.
– Make sure paper in use is not curled. Uncurl paper by bending it in the opposite direction of the curl.

● Pages are skewing
– Make sure the paper loaded in the input tray is aligned to the paper-width guides.
– Load paper into the printer only when it is not printing.

● Multiple pages are being picked up
– Make sure the paper-width guides are snug, but not tight, against the stack of paper.
– Make sure the input tray is not overloaded with paper.
– Use HP paper for optimum performance and efficiency.

Printing issues

What do you want to do?

Fix problems with page not printing (unable to print)

<table>
<thead>
<tr>
<th>HP Print and Scan Doctor</th>
<th>The HP Print and Scan Doctor is a Windows utility that will try to diagnose and fix the issue automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NOTE: This utility is only available for Windows operating system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshoot problems with print jobs not printing</th>
<th>Use an HP online troubleshooting wizard. Use an HP online troubleshooting wizard.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Get step-by-step instructions if the printer is not responding or printing.</td>
</tr>
</tbody>
</table>

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all languages.

General instructions for resolving unable to print issues

To resolve print issues (Windows)

NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try the following in order:

1. Check for error messages from the printer display and resolve them by following the onscreen instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable. If your computer is connected to the printer with a wireless connection, confirm that the connection is working.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending on your operating system, do one of the following:
1. From the Windows Start menu, click All apps, click Windows System, click Control Panel, and then click View devices and printers under Hardware and Sound menu.

2. Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.

3. From the Windows Start menu, click Devices and Printers.

4. From the Windows Start menu, click Control Panel, and then click Printers.

5. From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See what’s printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer Offline.

d. If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending on your operating system, do one of the following:

   - Windows 10: From the Windows Start menu, click All apps, click Windows System, click Control Panel, and then click View devices and printers under Hardware and Sound menu.

   - Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.

   - Windows 7: From the Windows Start menu, click Devices and Printers.

   - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

   - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Make sure the correct printer is set as the default printer.

   The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending on your operating system, do one of the following:

   Windows 10

   i. From the Windows Start menu, click All apps, and then click Windows System.

   ii. Click Control Panel, System and Security, and then click Administrative Tools.

   iii. Double-click Services.
iv. Right-click the Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click Start, and then click OK.

Windows 8.1 and Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or tap OK.

Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance, Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.
c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as Default Printer.
d. Try using your printer again.

6. Restart the computer.
7. Clear the print queue.

**To clear the print queue**

a. Depending on your operating system, do one of the following:
   - **Windows 10**: From the Windows Start menu, click All apps, click Windows System, click Control Panel, and then click View devices and printers under Hardware and Sound menu.
   - **Windows 8.1 and Windows 8**: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.
   - **Windows 7**: From the Windows Start menu, click Devices and Printers.
   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.
   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your printer to open the print queue.
c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.
d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.
e. Check the print queue again to make sure it is clear, and then try to print again.

**To check the power connection and reset the printer**

1. Make sure the power cord is firmly connected to the printer.
2. If (the Power button) on the printer is not lit, press this button to turn on the printer.
3. Disconnect the power cord from the printer.
4. Remove the battery from the rear of the printer.
5. Unplug the power cord from the wall outlet.
6. Wait at least 15 seconds.
7. Plug the power cord back into the wall outlet.
8. Reconnect the power cord to the printer.
9. If the printer does not turn on by itself, press (the Power button) to turn it on.
10. Try using the printer again.
11. Install the battery as described in Install or replace the battery.
To resolve print issues (OS X)

1. Check for error messages and resolve.
2. Disconnect and reconnect to the printer.
3. Verify that the printer is not paused or offline.

   **To verify that the product is not paused or offline**
   
   a. In **System Preferences**, click **Printers & Scanners**.
   
   b. Click the **Open Print Queue** button.
   
   c. Click a print job to select it.

      Use the following buttons to manage the print job:
      
      - **Delete**: Cancel the selected print job.
      - **Hold**: Pause the selected print job.
      - **Resume**: Continue a paused print job.
      - **Pause Printer**: Pause all print jobs in the print queue.

   d. If you made any changes, try to print again.

4. Restart the computer if the problem is not solved.

Fix print quality issues

<table>
<thead>
<tr>
<th>Step-by-step instructions for resolving most print quality issues</th>
<th>Troubleshoot print quality issues online</th>
</tr>
</thead>
</table>

General instructions for resolving print quality issues

**NOTE:** To avoid print quality problems, always turn the printer off using (the Power button), and wait until the button light goes out before you pull the plug or turn off a power strip. This allows the printer to move the cartridges to a capped position, where they are protected from drying out.

To improve print quality

1. Make sure you are using original HP cartridges.
2. Make sure you are using an appropriate paper type.

   Always make sure the paper you are printing on is flat and is not damaged, curled, or wrinkled. For more information, see **Tips for selecting and using paper**.

   For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For more information, see **Paper basics**.

   For best results when printing images, use HP Advanced Photo Paper.

   Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, dry place.

   When you are ready to print, remove only the paper you plan to use immediately. When you have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper from curling.
3. Make sure you have selected the appropriate paper type and print resolution in the software print settings.

**NOTE:** Selecting a higher print quality can result in a printout with higher definition but could use more ink and take longer to print.

4. Check the ink levels. For the procedure, see Check the estimated ink levels. If the cartridges are low on ink consider replacing them.

5. Print a diagnostics page if the cartridges are not low on ink.

To do this, you must:
- Load Letter, A4, or Legal unused plain white paper into the paper tray.
- Print out the page either using the printer software or the control panel.

**To print a diagnostics page from the printer software (Windows)**

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. In the printer software, click Print > Maintain Your Printer to access the printer toolbox.

c. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.

**To print a diagnostics page from the software (OS X)**

a. Open HP Utility.

b. Select your printer from the Devices list.

c. Click Test Page.

d. Click the Print Test Page button, and follow the onscreen instructions.

**To print a diagnostics page from the printer control panel**

a. On the printer control panel, press the Home button () to display the Home screen.

b. Select Setup, Print Reports, and then Print Quality Report.

   To select a function on a screen, use the arrow button (↑, ↓) to select it, and then press the OK button.

6. If the diagnostic page shows steaks or missing portions of the color and black boxes, perform automatic cleaning of the cartridges.

To do this, you must:
- Load Letter, A4, or Legal unused plain white paper into the paper tray.
- Perform the cleaning either using the printer software or the control panel.

**To clean the cartridges from the printer software (Windows)**

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. In the printer software, click Print > Maintain Your Printer to access the Printer Toolbox.

c. From the Device Services tab, click Clean Printer, and then follow the onscreen instructions.
To clean the cartridge from the software (OS X)

a. Open HP Utility.

**NOTE:** HP Utility is located in the **Applications** folder at the top level of the hard disk.

b. Select your printer from the **Devices** list.

c. Click **Clean Printheads**.

d. Click **Clean**, and follow the onscreen instructions.

To clean the cartridges from the printer control panel

a. On the printer control panel, press the Home button (\(\text{Home}\)) to display the Home screen.

b. Select **Setup**, **Tools**, and then **Clean Printhead**.

c. Follow the onscreen instructions to proceed.

If cleaning the printhead does not solve the problem, contact HP support. Go to [www.hp.com/support](http://www.hp.com/support). This website provides information and utilities that can help you correct many common printer problems. If prompted, select your country/region, and then click **All HP Contacts** for information on calling for technical support.

**CAUTION:** Clean the printhead only when necessary. Unnecessary cleaning wastes ink and shortens the life of the printhead.

7. Align the cartridges.

**NOTE:** Aligning the cartridges ensures high-quality output. The printer prompts you to align the cartridges every time you install a new cartridge. If you remove and reinstall the same cartridge, it will not prompt you to align the cartridges as the printer remembers the alignment values for that cartridge.

To do this, you must:

- Load Letter, A4, or Legal unused plain white paper into the paper tray.
- Perform the alignment either using the printer software or the control panel.

To align the cartridges from the printer software (Windows)

a. Open the HP printer software. For more information, see [Open the HP printer software (Windows)].

b. In the printer software, click **Print** > **Maintain Your Printer** to access the printer toolbox window.

c. From the **Device Services** tab, click **Align Cartridges**.

The printer prints an alignment sheet.

d. Follow the instructions on the printer screen to align the cartridges.

To align the cartridges from the software (OS X)

a. Open HP Utility.

**NOTE:** HP Utility is located in the **Applications** folder at the top level of the hard disk.

b. Select your printer from the **Devices** list.

c. Click **Align** and follow the onscreen instructions.
To align the cartridges from the printer control panel

a. On the printer control panel, press the Home button ( ağ) to display the Home screen.

b. Select Setup, Tools, and then Align Printer.

c. Follow the onscreen instructions to proceed.

Network and connection issues

What do you want to do?

Fix wireless connection

Choose one of the following troubleshooting options.

<table>
<thead>
<tr>
<th>HP Print and Scan Doctor</th>
<th>The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically. NOTE: This utility is only available for Windows operating system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use an HP online troubleshooting wizard</td>
<td>Troubleshoot a firewall or antivirus issue, if you suspect that it is preventing your computer from connecting to the printer. • Troubleshoot your wireless problem, whether your printer has never been connected or it was connected and is no longer working.</td>
</tr>
</tbody>
</table>

**NOTE:** The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all languages.

General instructions for wireless troubleshooting

Check the network configuration or print the wireless test report to assist in diagnosing network connection issues.

1. On the printer control panel, press the wireless button ( ağ).

2. Select Settings by pressing the ( ) button.

3. Select Print Reports, and then select Configuration Page or Test Report.

To select a function on a screen, use the arrow button ( , ) to select it, and then press the OK button.

Find network settings for wireless connection

Choose one of the following troubleshooting options.

<table>
<thead>
<tr>
<th>HP Print and Scan Doctor</th>
<th>The HP Print and Scan Doctor is a utility that can tell you the network name (SSID) and password (network key). NOTE: This utility is only available for Windows operating system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use an HP online troubleshooting wizard</td>
<td>Learn how to find your network name (SSID) and wireless password.</td>
</tr>
</tbody>
</table>

**NOTE:** The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all languages.
Fix Wi-Fi Direct connection

Use an HP online troubleshooting wizard | Troubleshoot your Wi-Fi Direct problem or learn how to configure Wi-Fi Direct.

**NOTE:** The HP online troubleshooting wizards may not be available in all languages.

**General instructions for Wi-Fi Direct troubleshooting**

1. Check if the printer turns on Wi-Fi Direct:
   - On the printer control panel, press the Wi-Fi Direct button 📴.
2. From your wireless computer or mobile device, turn on the wireless connection, and then search for and connect to the Wi-Fi Direct of your printer.
3. Enter the Wi-Fi Direct password when prompted.
4. If you are using a mobile device, make sure you have installed a compatible printing app. For more information about mobile printing, visit the HP Mobile Printing website at [www.hp.com/go/mobileprinting](http://www.hp.com/go/mobileprinting). If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing site in another country/region or language.

**Printer hardware issues**

**TIP:** Run the HP Print and Scan Doctor to diagnose and automatically fix printing issues. The application is only available in some languages.

**The printer shuts down unexpectedly**

- Check the power and power connections.
  - Make sure the printer's power cord is connected firmly to a functioning power outlet.
- Check the battery status after disconnect the printer from power. For installation and checking the status of battery, see Install or replace the battery.

**Printhead alignment fails**

- If the alignment process fails, make sure you have loaded unused, plain white paper into the input tray. If you have colored paper loaded in the input tray when you align the cartridges, the alignment fails.
- If the alignment process fails repeatedly, you may need to clean the printhead, or you might have a defective sensor. To clean the printhead, see Maintain the printhead and cartridges.
- If cleaning the printhead does not solve the problem, contact HP support. Go to [www.hp.com/support](http://www.hp.com/support). This website provides information and utilities that can help you correct many common printer problems. If prompted, select your country/region, and then click All HP Contacts for information on calling for technical support.

**Resolve printer failure**

Complete the following steps to resolve such problems.

1. Press 📢 (the Power button) to turn off the printer.
2. Unplug the power cord.
3. Remove the battery if a battery has been installed.
4. Plug in the power cord.

5. Press ♦️ (the Power button) to turn on the printer.

6. Install the battery as described in Install or replace the battery.

If this problem persists, write down the error code provided in the message, and then contact HP support. For more information about contacting HP support, see HP support.

Get help from the printer control panel

You can use the help topics provided on the printer control panel to learn more about the printer. Some help topics provide vivid animations to guide you through some procedures more easily, for example, clearing jams.

To access those help topics, press the Home button (.Gravity) to display the Home screen, and then press the help button 🟢.

When you are not in the Home screen, pressing the help button displays only the help information for the current screen.

Understand printer reports

You can print the following reports to help troubleshoot problems with the printer.

- Printer status report
- Network configuration page
- Print quality report
- Wireless test report

Printer status report

Use the printer status report to view current printer information and cartridge status. Also use the printer status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, it is often useful to print the printer status report before calling.

Network configuration page

If the printer is connected to a network, you can print a network configuration page to view the network settings for the printer and a list of networks detected by your printer. The last page of the report includes a list of all detectable wireless networks in the area, along with signal strength and the channels being used. This might help you select a channel for your network which is not heavily used by other networks (which will improve network performance).

You can use the network configuration page to help troubleshoot network connectivity problems. If you need to call HP, it is often useful to print this page before calling.
Print quality report

Print quality problems can have many causes—software settings, a poor image file, or the printing system itself. If you are unhappy with the quality of your prints, a Print Quality Diagnostic page can help you determine if the printing system is working correctly.

Wireless test report

Print the wireless test report for information about the printer wireless connection. The wireless test report provides information about the printer status, hardware (MAC) address, and IP address. If the printer is connected to a network, the test report displays details about the network settings.

To print the wireless test report

1. On the printer control panel, press the Home button (HOME) to display the Home screen.
2. Select Network, Print Reports, and then Test Report.

To select a function on a screen, use the arrow button (▲, ▼) to select it, and then press the OK button.

Solve problems using HP ePrint

If you are having problems using HP ePrint, check the following:

- Make sure the printer is connected to a wireless network and the USB connection is disconnected.

  **NOTE:** You cannot use this feature if the printer is connected using a USB cable.

- Make sure the latest product updates have been installed on the printer.
- Make sure the network hub, switch, or router is turned on and working correctly.
- When you are using HP ePrint, check the following:
  - Make sure the printer’s email address is correct.
  - Make sure that the printer’s email address is the only address listed in the “To” field of the email message. If other email addresses are listed in the “To” field, the attachments you are sending might not print.
  - Make sure you are sending documents that meet the HP ePrint requirements. For more information, visit HP Connected at www.hpconnected.com. This site might not be available in all countries/regions.
- If your network uses proxy settings when connecting to the Internet, make sure the proxy settings you are entering are valid:
  - Check the settings being used by the web browser you are using (such as Internet Explorer, Firefox, or Safari).
  - Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in either the printer control panel or the embedded web server. Otherwise, you will not be able to use HP ePrint.

For more information, see Set up HP ePrint.

**TIP:** For additional help on setting up and using Web Services, visit HP Connected at www.hpconnected.com. This site might not be available in all countries/regions.
Maintain the printer

What do you want to do?

Clean the exterior

⚠️ WARNING! Before cleaning the printer, turn the printer off by pressing (the Power button) and unplug the power cord from the electrical socket and/or remove battery pack.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the interior of the printer, as well as from the printer control panel.

Maintain the printhead and cartridges

If you are experiencing print quality issues, you might have a problem with the printhead.

⚠️ NOTE: Turning the printer off improperly can cause print quality problems. To turn the printer off, always use (the Power button). This allows the printer to cap the printhead and protect it from damage.

- Clean the printhead if your cartridge is not low on ink and the printout is streaked or has any incorrect or missing colors.

  There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an increasing amount of ink. After each stage, review the quality of the printed page. You should only initiate the next phase of cleaning if the print quality is poor.

  If print quality still seems poor after you complete all stages of cleaning, try aligning the printer. If print quality problems persist after cleaning and aligning, contact HP support. For more information, see HP support.

  ⚠️ NOTE: The cleaning process takes a few minutes. Some noise might be generated in the process.

- Align the printer when the print quality diagnostic page shows misalignment or white lines through any of the blocks of color, or if you are seeing jagged lines in your printouts.

  The printer automatically aligns the printhead during the initial setup.

  ⚠️ NOTE: Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of the cartridges.

To clean or align the printheads

1. Load Letter or A4 unused plain white paper into the input tray. For more information, see Load paper.
2. On the printer control panel, press the Home button ( ) to display the Home screen.
3. Select Setup, and then Tools.
   To select a function on a screen, use the arrow button ( , ▼) to select it, and then press the OK button.
4. From the Tools screen, select the desired option, and then follow the onscreen instructions.

  ⚠️ NOTE: Alternatively, you can use the HP printer software or embedded web server (EWS) to align the printhead. See Open the HP printer software (Windows) and Open the embedded web server.
Restore defaults and settings

If you disable some functions or change some settings and want to change them back, you can restore the printer to the original factory settings or network settings.

To restore the printer to the original factory defaults

1. On the printer control panel, press the Home button (🏠) to display the Home screen.
2. Select Setup, and then select Tools.
   To select a function on a screen, use the arrow button (↑, ↓) to select it, and then press the OK button.
3. Select Restore.
4. Follow the onscreen instructions to complete the restoring.

To restore the printer to the original network settings

1. On the printer control panel, press the Home button (🏠) to display the Home screen.
2. Select Setup, and then Network.
   To select a function on a screen, use the arrow button (↑, ↓) to select it, and then press the OK button.
   A message appears stating that the network defaults will be restored.
4. Choose Yes by pressing the button ➡.
   The restoring starts. After a few seconds, a message appears stating that the network defaults have been restored.
5. To verify if the network settings are reset successfully, press the OK button to return from the message screen. After that, select Print Reports, and then select Configuration Page to print the network configuration page.

After restoring, previously configured wireless settings are removed.

HP support

For the latest product updates and support information, visit the printer support website at www.hp.com/support. HP online support provides a variety of options for help with your printer:

- **Drivers & downloads**: Download software drivers and updates, as well as product manuals and documentation that came in the box with your printer.
- **HP support forums**: Visit HP Support Forums for answers to common questions and issues. You can view questions posted by other HP customers, or sign in and post your own questions and comments.
- **Troubleshooting**: Use HP online tools to detect your printer and find recommended solutions.
Contact HP

If you need help from an HP technical support representative to solve a problem, visit the Contact Support website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted support for out-of-warranty customers may require a fee):

- Chat with an HP support agent online.
- Call an HP support agent.

When contacting HP support, be prepared to provide the following information:
- Product name (Located on the printer, such as HP OfficeJet 200 Mobile series)
- Product number (located near the cartridge access area)
- Serial number (located on the side of the printer)

Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at http://www.register.hp.com.

Additional warranty options

Extended service plans are at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the extended warranty options available for your printer.
A   Technical information

This section contains the following topics:

- Specifications
- Regulatory information
- Environmental product stewardship program

Specifications

For more information, visit www.hp.com/support. Select your country or region. Click Product Support & Troubleshooting. Enter the name shown on the front of the printer, and then select Search. Click Product information, and then click Product specifications.

System requirements

- For information about software and system requirements or future operating system releases and support, visit the HP online support website at www.hp.com/support.

Environmental specifications

- Recommended operating temperature: 15°C to 30°C (59°F to 86°F)
- Allowable operating temperature: 5°C to 40°C (41°F to 104°F)
- Humidity: 15 to 95% RH (limited to a 31°C dew point temperature)
- Nonoperating (storage) temperature: -40°C to 60°C (-40°F to 140°F)

Input tray capacity

- Plain paper sheets (64 to 100 g/m² [104 to 163 lb]): Up to 50
- Envelopes: Up to 5
- Index cards: Up to 20
- Hagaki paper sheets: Up to 20
- Photo paper sheets: Up to 20

Paper size and weights

For the list of supported paper sizes, see the HP printer software.

- Plain paper: 64 g/m² and above (104 lb and above)
- Envelopes: 75 to 90 g/m² (20 to 24 lb)
- Cards: Up to 200 g/m² (110 lb index maximum)
- Photo paper: 300 g/m² (80 lb)
Print specifications

- Print speeds vary according to the complexity of the document and printer model
- Method: drop-on-demand thermal officejet
- Language: PCL 3
- Print resolution:
  For a list of supported print resolutions, visit the support website at www.hp.com/support.
- Print margins:
  For margin settings for different medias, visit the support website at www.hp.com/support.

Cartridge yield

- Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Regulatory information

The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

- Regulatory Model Number
- FCC statement
- Notice to users in Korea
- VCCI (Class B) compliance statement for users in Japan
- Notice to users in Japan about the power cord
- Visual display workplaces statement for Germany
- European Union Regulatory Notice
  - Products with wireless functionality
- Declaration of conformity
- Regulatory information for wireless products
  - Exposure to radio frequency radiation
  - Notice to users in Brazil
  - Notice to users in Canada
  - Notice to users in Taiwan
  - Notice to users in Mexico
  - Notice to users in Japan
  - Notice to users in Korea

Regulatory Model Number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SDGOB-1601-01. This regulatory number should not be confused with the marketing name (HP OfficeJet 200 Mobile series) or product number (CZ993A, L9B95A, etc.).
FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
HP Inc. 1501 Page Mill Road,
Palo Alto, CA 94304, U.S.A.

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

| B 급 기기 (가정용 방송통신기기) | 이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다. |
VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B

Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。

Visual display workplaces statement for Germany

GS-Erklärung (Deutschland)
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following website: [www.hp.com/go/certificates](http://www.hp.com/go/certificates) (Search with the product model name or its Regulatory Model Number (RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Products with wireless functionality

EMF

- This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.
  
  If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of 20 cm ensures that radio frequency exposure levels comply with EU requirements.
Wireless functionality in Europe

- This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, Norway and Switzerland.
DECLARATION OF CONFORMITY

according to ISO/IEC 17050-1 and EN 17050-1

DoC #: SDG08-1601-01-R1

Supplier's Name: Hewlett-Packard Company
Supplier's Address: 1115 SE 164th Ave., Vancouver, WA 98683, USA

declares, that the product
Product Name and Model: HP OfficeJet 200 Mobile Printer
HP OfficeJet 200 Mobile Printer Ink Advantage
HP OfficeJet 200 C Mobile Printer

Regulatory Model Number: 1) SDG08-1601-01
Product Options: All
Radio Module: SDG08-1391 (802.11 b/g/n)
Power Adapter: N/A

conforms to the following Product Specifications and Regulations:

EMC: Class B
CISPR 22:2008 / EN 55022: 2010
CISPR 24:2010 / EN 55024: 2010
IEC 61000-3-3: 2008 / EN 61000-3-3: 2008
FCC CFR 47 Part 15 / ICES-003, Issue 5 Class B

Safety:
EN 62479: 2010

Telecom:
EN 300 328 v1.8.1
EN 301 489-1 v1.9.2
EN 301 489-17 v2.2.1

Energy Use:
Regulation (EC) No. 1275/2008
ENERGY STAR® Qualified Imaging Equipment Operational Mode (OM) Test Procedure
EN 50564:2011
IEC 62301:2005

RoHS:
EN 50581:2012


This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.

May 31, 2015
Vancouver, WA, USA

Local contact for regulatory topics only:
EU: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, Germany
U.S.: Hewlett-Packard, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 650-857-1501

www.hp.eu/certificates
Regulatory information for wireless products

This section contains the following regulatory information pertaining to wireless products:

- Exposure to radio frequency radiation
- Notice to users in Brazil
- Notice to users in Canada
- Notice to users in Taiwan
- Notice to users in Mexico
- Notice to users in Japan
- Notice to users in Korea

Exposure to radio frequency radiation

**Exposure to radio frequency radiation**

⚠ **Caution** The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the antenna shall not be less than 20 cm (8 inches) during normal operation.

Notice to users in Brazil

**Aviso aos usuários no Brasil**

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário.
Notice to users in Canada

Notice to users in Canada/Note à l’attention des utilisateurs canadiens

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or less) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

WARNING! Exposure to Radio Frequency Radiation The radiated output power of this device is below the Industry Canada radio frequency exposure limits. Nevertheless, the device should be used in such a manner that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human proximity to the antennas should not be less than 20 cm (8 inches).

Conformément au Règlement d’Industrie Canada, cet émetteur radiélectrique ne peut fonctionner qu’avec une antenne d’un type et d’un gain maximum (ou moindre) approuvé par Industrie Canada. Afin de réduire le brouillage radiélectrique potentiel pour d’autres utilisateurs, le type d’antenne et son gain doivent être choisis de manière à ce que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas celle nécessaire à une communication réussie.

Cet appareil est conforme aux normes RSS exemptes de licence d’Industrie Canada. Son fonctionnement dépend des deux conditions suivantes : (1) cet appareil ne doit pas provoquer d’interférences récevues et (2) doit accepter toutes interférences reçues, y compris des interférences pouvant provoquer un fonctionnement non souhaité de l’appareil.

AVERTISSEMENT relatif à l’exposition aux radiofréquences. La puissance de rayonnement de cet appareil se trouve sous les limites d’exposition de radiofréquences d’Industrie Canada. Néanmoins, cet appareil doit être utilisé de telle sorte qu’il soit mis en contact le moins possible avec le corps humain.

Afin d’éviter le dépassement éventuel des limites d’exposition aux radiofréquences d’Industrie Canada, il est recommandé de maintenir une distance de plus de 20 cm entre les antennes et l’utilisateur.

Notice to users in Taiwan

低功率電波輻射性電機管理辦法

第十二條
經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻率、加大功率或變更設計之特性及功能。

第十四條
低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方得繼續使用。

前項合法通信，指依電信法規定之電話或電報通信；低功率射頻電機忍受合法通信或工業、科學及醫療用電波輻射性電機設備之干擾。
Notice to users in Mexico

**Aviso para los usuarios de México**

La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operación no deseada.

Para saber el modelo de la tarjeta inalámbrica utilizada, revise la etiqueta regulatoria de la impresora.

Notice to users in Japan

この機器は技術基準適合証明又は工事設計認証を受けた無線設備を搭載しています。

Notice to users in Korea

해당 무선설비는 전파혼신 가능성이 있으므로 인명안전과 관련된 서비스는 할 수 없음

Environmental product stewardship program

HP is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair. For more information, visit HP’s Commitment to the Environment website at:

[www.hp.com/hpinfo/globalcitizenship/environment](http://www.hp.com/hpinfo/globalcitizenship/environment)

- Eco-Tips
- European Union Commission Regulation 1275/2008
- Paper
- Plastics
- Material safety data sheets
- Recycling program
- HP inkjet supplies recycling program
- Power consumption
- Disposal of waste equipment by users
- Chemical substances
- Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)
- Restriction of hazardous substance (Ukraine)
- Restriction of hazardous substance (India)
- China SEPA Eco Label User Information
Eco-Tips

HP is committed to helping customers reduce their environmental footprint. Please visit the HP Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

European Union Commission Regulation 1275/2008

For product power data, including the power consumption of the product in networked standby if all wired network ports are connected and all wireless network ports are activated, please refer to section P14 ‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/environment/productdata/itecodesktop-pc.html.

Paper

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/recycle

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used cartridges free of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
Power consumption

HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, you should protect human health and the environment by handing over your waste equipment to a designated collection point for the recycling of waste electrical and electronic equipment. For more information, please contact your household waste disposal service, or go to http://www.hp.com/recycle.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.
### Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)

限用物質含有情況標示聲明書  

Declaration of the Presence Condition of the Restricted Substances Marking

<table>
<thead>
<tr>
<th>單元</th>
<th>Unit</th>
<th>鉛 (Pb)</th>
<th>汞 (Hg)</th>
<th>鎘 (Cd)</th>
<th>六價鉻 (Cr⁶⁺)</th>
<th>多溴聯苯 (PBB)</th>
<th>多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>外殼和紙匣 (External Casings and Trays)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>電線 (Cables)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>印刷電路板 (Printed Circuit Boards)</td>
<td>—</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>列印引擎 (Print Engine)</td>
<td>—</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>列印機組件 (Print Assembly)</td>
<td>—</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>噴墨印表機墨水匣 (Print Supplies)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>列印機配件 (Print Accessory)</td>
<td>—</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

備考 1. “超出 0.1 wt %” 及“超出 0.01 wt %”係指限用物質之百分比含量超出百分比含量基準值。

Note 1: "Exceeding 0.1 wt %" and "exceeding 0.01 wt %" indicate that the percentage content of the restricted substance exceeds the reference percentage value of presence condition.

備考 2. “0”係指該項限用物質之百分比含量未超出百分比含量基準值。

Note 2: "0" indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of presence.

備考 3. “−”係指該項限用物質為排除項目。

Note 3: The “−” indicates that the restricted substance corresponds to the exemption.

若要存取產品的最新使用指南或手冊，請前往 [www.support.hp.com](http://www.support.hp.com) 選取搜尋您的產品，然後依照畫面上的指示繼續執行。

To access the latest user guides or manuals for your product, go to [www.support.hp.com](http://www.support.hp.com). Select [Find your product](http://www.support.hp.com), and then follow the onscreen instructions.
Restriction of hazardous substance (Ukraine)

Технічний регламент щодо обмеження використання небезпечних речовин (Україна)

Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою Кабінету Міністрів України від 3 грудня 2008 № 1057

Restriction of hazardous substance (India)

Restriction of hazardous substances (India)

This product complies with the "India E-waste (Management and Handling) Rule 2011" and prohibits use of lead, mercury, hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations exceeding 0.1 weight % and 0.01 weight % for cadmium, except for the exemptions set in Schedule 2 of the Rule.

China SEPA Eco Label User Information

中国环境标识认证产品用户说明

噪声大于63.0Db(A)的办公设备不宜放置于办公室内，应远离靠近住宅区域使用。

如需长时间使用本产品或打印大量文件，请确保在通风良好的房间内使用。

如您确认本产品处于噪声状态，请按下电源关闭按钮，并将插头插入电源插座断开。

您可以使用再生纸，以减少资源耗费。
复印机、打印机和传真机能源效率标识

实施规则

依据“复印机、打印机和传真机能源效率标识实施规则”，该打印机具有中国能效标识。标识上显示的能效等级和操作模式值根据“复印机、打印机和传真机能效限定值及能效等级”标准（“GB 21521”）来确定和计算。

1. 能效等级

产品能效等级分为 3 级。其中 1 级能效最高。能效限定值根据产品类型和打印速度由标准确定。能效等级则根据基本功耗水平以及网络接口和内存等附加组件和功能的功率因子之和来计算。

2. 能效信息

连续打印

- 操作模式功率
  睡眠状态的能耗按照 GB 21521 标准来衡量和计算。该数据以瓦特 (W) 表示。

- 待机功率
  待机状态是产品连接到电网电源上的功率状态。该状态可以延续无限长时间，但使用者无法改变此状态下的功率。对于“常规设备”产品，“待机”状态通常相当于“关闭”状态，但可能相当于“准备”状态或“睡眠”状态。该数据以瓦特 (W) 表示。

- 睡眠状态静默延迟时间
  出厂前由制造商设置的时间决定了该产品在完成主功能后进入低耗模式（例如睡眠、自动关机）的时间。该数据以分钟表示。

- 附加功能功率因子之和
  网络接口和内存等附加功能的功率因子之和。该数据以瓦特 (W) 表示。

标识上显示的能耗数据是根据典型配置测量得出的数据。此类配置包含登记备案的打印机依据复印机、打印机和传真机能源效率标识实施规则所选的所有配置。因此，该特定产品型号的实际能耗可能与标识上显示的数据有所不同。

要了解规范的更多详情。请参考最新版的 GB 21521 标准。
## The Table of Hazardous Substances/Elements and their Content (China)

<table>
<thead>
<tr>
<th>Partial Name</th>
<th>Pb</th>
<th>Cd</th>
<th>Co</th>
<th>Cr(VI)</th>
<th>PBB</th>
<th>PBDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body and Casing</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LCD</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Printer Module</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Printer Drum</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Monitor</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Monitor Housing</td>
<td>O</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Moving Mechanism</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Interface</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Battery Board</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Battery</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>External Power</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

This table follows the standards of SJ/T 11364.

X: Indicates that the material in each part of the product contains certain hazardous substances above the limit set by GB/T 26572.

ENWW indicates that the product is made in Taiwan.

---

### EPEAT

EPEAT most HP products are designed to meet EPEAT. EPEAT is a comprehensive environmental rating that helps identify greener electronics equipment. For more information on EPEAT, go to [www.epeat.net](http://www.epeat.net). For information on HP's EPEAT registered products, go to [www.hp.com/hpinfo/globalcitizenship/environment/pdf/epeat_printers.pdf](http://www.hp.com/hpinfo/globalcitizenship/environment/pdf/epeat_printers.pdf).

### Battery disposal in Taiwan

廃電池請回收
United States Call2Recycle (RBRC)

California Rechargeable Battery Take-back Notice

HP encourages customers to recycle used electronic hardware, HP original cartridges, and rechargeable batteries. For more information about recycling programs, go to www.hp.com/recycle.
EU Battery Directive

European Union Battery Directive

This product contains a battery that is used to maintain data integrity of real-time clock or product settings and is designed to last the life of the product. Any attempt to service or replace this battery should be performed by a qualified service technician.

Directive sur les batteries de l’Union Européenne

Ce produit contient une batterie qui permet de maintenir l’intégrité des données pour les paramètres du produit ou l'horloge en temps réel et qui a été conçu pour durer aussi longtemps que le produit. Toute tentative de réparation ou de remplacement de cette batterie doit être effectuée par un technicien qualifié.

Batteriend-Richtlinie der Europäischen Union

Dieses Produkt enthält eine Batterie, die auch dann die Datensicherheit der Zeitstunde sowie der Produkteinstellungen zu sichert, und die für den Lebenszyklus des Produktes bestimmt ist. Jegliche Versuche der Reparatur oder des Austausches dieser Batterie sind nur durch qualifizierten Fachleuten zu erfolgen.

Direttiva dell’Unione Europea relativa alla raccolta, il trattamento e allo smaltimento di batterie e accumulatori

Questo prodotto contiene una batteria utilizzata per assicurare l’integrità dei dati dell’orologio e i parametri del prodotto e che ha durata di vita del prodotto. Eventuali interventi di riparazione o sostituzione della batteria devono essere eseguiti da un tecnico dell’assistenza qualificato.

Direktiva sobre bateries de la Unió Europea

Este product conté una bateria que es utilitzar per mantenir l'integritat dels dades per a paràmetres del producte o l'horloge en temps reall i que ha estat concebuda per durar tant temps com el producte. Tots els intents de reparació o substitució de la bateria han de ser realitzats per un tècnic en assistència qualificat.

Diretrizes sobre baterias para a União Europeia

Este produto contém uma bateria que é usada para garantir a integridade dos dados para parâmetros do produto ou o relógio e que tem vida útil do produto. Qualquer tentativa de reparação ou substituição da bateria deve ser realizada por um técnico qualificado.

Direktyva dėl baterijų ES viešbučiose

Šis įrenginys gali turėti įranga, kuriai būtų reikalinga baterija, kai kažkur yra kelias bunkerių arba jokių kitų. Todėl, jei įrenginį naudojate, labai svarbu kartu su jų kiminciumi baterijomis. Įrenginiams, kurie turi baterijas, gali būti naudojami tik autorizuotais metodus.
Index

A
accessibility 2
align printhead 57

B
buttons, control panel 8

C
cartridge access door, locating 6
cartridges 7, 34
check ink levels 31
locating 6
part numbers 34
replace 32
tips 31
clean
   exterior 57
   printhead 57
connectors, locating 7
control panel
   buttons 8
   lights 8
customer support
   warranty 59

D
diagnostic page 56

E
embedded web server
   about 41
   opening 42
   troubleshoot, cannot be opened 42
environmental specifications 60
environmental sustainability program 68
EWS. See embedded web server

G
glass, scanner
   locating 5

H
HP Utility (OS X)
   opening 41
humidity specifications 60

I
ink levels, check 31
IP address
   checking for printer 43
IP settings 37

J
jams
   clear 44
   paper to avoid 11

L
lights, control panel 8

M
Mac OS 21
maintain
   page smear 57
   printhead 57
maintenance
   align printhead 57
   check ink levels 31
   clean 57
   clean printhead 57
diagnostic page 56
   printhead 57
   replace cartridges 32
   margins
   setting, specifications 61
   multi-feeds, troubleshoot 46

N
networks
   connector illustration 7
   IP settings 37
   settings, change 37
   wireless communication setup 35
   wireless settings 55

O
operating systems supported 60
OS X
   HP Utility 41
output tray
   locating 5

P
paper
   clear jams 44
   HP, order 11
   load tray 12
   selecting 11
   skewed pages 46
   specifications 60
troubleshoot feeding 45
   paper-feed problems, troubleshoot 45
   power
   troubleshoot 54
   power input, locating 7
   print
diagnostic page 56
   troubleshoot 54
Print brochures
   print 21
   print quality
   clean page smear 57
   print quality report 56
printer software (Windows)
   about 41
   opening 18, 41
printer status report
   information on 55
   printhead 57
   clean 57
   printhead, align 57

R
radio interference
   regulatory information 66
rear access panel
  illustration 7
recycle
cartridges 69
regulatory information 61, 66
regulatory model number 61
replace cartridges 32
reports
diagnostic 56
wireless test 56

S
scanner glass
locating 5
settings
  network 37
skew, troubleshoot
  print 46
specifications
  paper 60
  physical 60
  system requirements 60
status
  network configuration page 55
system requirements 60

T
temperature specifications 60
trays
  clear paper jams 44
  load paper 12
  locating 5
  paper-width guides illustration 5
  troubleshoot feeding 45
troubleshoot
  control panel help system 55
  embedded web server 42
  multiple pages are picked 46
  network configuration page 55
  paper not picked up from tray 45
  paper-feed problems 45
  power 54
  print 54
  printer status report 55
  skewed pages 46

U
USB connection
  port, locating 5, 7

W
warranty 59
websites
  accessibility information 2
  environmental programs 68
Windows
  system requirements 60
wireless communication
  regulatory information 66
  set up 35
  wireless test report 56